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chapter 1

    ❱ Learn about Microsoft Office 2013 

and its applications Word, Excel, 

PowerPoint, and Access 

  ❱ Demonstrate how to open, save, 

and close files 

  ❱ Recognize Office 2013 common 

features and navigation elements 

  ❱ Modify account information and the 

look of Office 

  ❱ Create new files 

  ❱ Use Microsoft Help  

Essential Skills 
for Office 2013 

  introduction 
  This chapter introduces you to Microsoft Office 2013. You will learn about the shared features across the Office 2013 

applications and how to navigate common interface elements such as the Ribbon and Quick Access Toolbar. You will 

learn how to open and close files as well as learn how to work with messages that appear when you first open files. 

You will become familiar with the Office account and learn how to modify the account as well as the look of Office 

2013. Introductory features such as creating and closing files and using Office Help are explained.    

skills

 Skill 1.1 Introduction to Microsoft Office 2013 

 Skill 1.2 Opening Files 

 Skill 1.3 Closing Files 

 Skill 1.4 Getting to Know the Office 2013 
User Interface 

 Skill 1.5 Using the Start Page 

 Skill 1.6 Changing Account Information 

 Skill 1.7 Changing the Look of Office 

 Skill 1.8 Working in Protected View 

 Skill 1.9 Picking Up Where You Left Off 

 Skill 1.10 Creating a New Blank File 

 Skill 1.11 Using Help 

 Skill  1.12 Working with File Properties 

 Skill 1.13 Saving Files to a Local Drive 

 Skill 1.14 Saving Files to a SkyDrive 

 Skill 1.15 Saving Files with a New Name 

 Skill 1.16 Closing the Application  

  In this chapter, you will learn the following skills: 
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 Skill 1.1 Introduction to Microsoft 
Office 2013 

Microsoft Office 2013 is a collection of business “productivity” applications (computer pro-
grams designed to make you more productive at work, school, and home). The most popular 
Office applications are:

  Microsoft Word   —A word processing program. Word processing software allows you to 
create text-based documents, similar to how you would type a document on a typewriter. 
However, word processing software offers more powerful formatting and design tools, 
allowing you to create complex documents, including reports, résumés, brochures, and 
newsletters.

FIGURE OF 1.1
Microsoft Word 2013

  Microsoft Excel   —A spreadsheet program. Originally, spreadsheet applications were 
viewed as electronic versions of an accountant’s ledger. Today’s spreadsheet applications 
can do much more than just calculate numbers—they include powerful charting and 
data analysis features. Spreadsheet programs can be used for everything from personal 
budgets to calculating loan payments.

FIGURE OF 1.2
Microsoft Excel 2013
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  Microsoft PowerPoint   —A presentation program. Such applications enable you to create 
robust, multimedia presentations. A presentation consists of a series of electronic slides. 
Each slide contains content, including text, images, charts, and other objects. You can 
add multimedia elements to slides, including animations, audio, and video.

FIGURE OF 1.3
Microsoft PowerPoint 2013

  Microsoft Access   —A database program. Database applications allow you to organize and 
manipulate large amounts of data. Databases that allow you to relate tables and databases 
to one another are referred to as  relational  databases. As a database user, you usually see 
only one aspect of the database—a  form.  Database forms use a graphical interface to 
allow a user to enter record data. For example, when you fill out an order form online, 
you are probably interacting with a database. The information you enter becomes a 
record in a database  table.  Your order is matched with information in an inventory table 
(keeping track of which items are in stock) through a  query.  When your order is filled, a 
database  report  can be generated for use as an invoice or a bill of lading.

FIGURE OF 1.4
Microsoft Access 2013

 To open one of the Office applications using the Windows 8 operating system:
    1. Display the  Start screen.   
   2. In the  Pinned Apps  section, click the tile of the application you want to open.    
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 To open one of the Office applications using the Windows 7 operating system:
    1. Click the Windows  Start  button (located in the lower left corner of your computer 

screen).  
   2. Click  All Programs.   
   3. Click the  Microsoft Office  folder.  
   4. Click the application you want to open.    

You can download a free trial version of Microsoft Office from Microsoft’s Web site (http://office.microsoft.com). The 
trial allows you to try the applications before buying them. When your trial period ends, if you haven’t purchased the 
full software license yet, you will no longer be able to use the applications (although you will continue to be able to 
open and view any files you previously created with the trial version).

tips & tricks

There are two main versions of Microsoft Office, each offering a different way to pay for the program:

  Office 365—This version allows you to download and install Office and pay for it on a yearly or monthly 
subscription basis. It includes full versions of the different Office applications along with online storage services 
for your files. When the next version of Office is released, the subscription can be transferred to the new version. 
If you do not want to install the full version of Office on your computer, you can access limited versions of each 
application online with an Office 365 subscription.

  Office 2013—This version allows you to install Office and pay for it once, giving you a perpetual license for the 
programs. This means that when the next version of Office is released, you will need to purchase the application 
suite again. You can associate a Windows Live account with Office 2013, giving you access to online storage for 
your files.

  If you are a home user, business, or a student, there are different purchasing options for both Office 365 and 
Office 2013. Both versions require that you are running the Windows 7 or Windows 8 operating system.

tell me more
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 Skill 1.2 Opening Files 
 Opening a file retrieves it from storage and displays it on your computer screen. The steps for 
opening a file are the same for Word documents, Excel spreadsheets, PowerPoint presenta-
tions, and Access databases. 

To open an existing file from your computer:
   1. Click the  File  tab to open Backstage view.  
   2. Click  Open.   
   3. The  Open  page displays listing the recently opened files by default.  
   4. Click  Computer.   
 5. A list of folders you have recently opened files from appears on the right. Click a folder 

to open the  Open  dialog with that folder displayed.

FIGURE OF 1.5

Open

Recent Folders List

Click Computer to 
open files stored on 
your local machine.

   6. Select the file name you want to open in the large list box.  
 7. Click the  Open  button in the dialog.
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FIGURE OF 1.6

Select the file you want to open.

Open Button

If you do not see the folder containing the file you want to open, click the Browse button. The Open dialog will open to 
your Documents folder. Navigate to the location where the file you want to open is located, select the file, and click Open.

tips & tricks

The screen shot shown here is from Word 2013 running on the Microsoft Windows 8 operating system. Depending 
on the operating system you are using, the Open dialog will appear somewhat different. However, the basic steps for 
opening a file are the same regardless of which operating system you are using.

tell me more

To display the Open page in Backstage view, you can also press Ctrl  + O  on the keyboard.

To open the file from within the Open dialog, you can also:
 ❱ Press the Enter  key once you have typed or selected a file name.

 ❱ Double-click the file name.

another method

Try this skill on your own:
 1. Open the student data fi le of1-SpaNewsletter.

NOTE: You may see a yellow security message at the top of the window. See the skill Working in Protected View 
to learn more about security warning messages.

 2. Keep the fi le open to work on the next skill.

let me try
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 Skill 1.3 Closing Files 
 Closing a file removes it from your computer screen and stores the last-saved version for 
future use. If you have not saved your latest changes, most applications will prevent you from 
losing work by asking if you want to save the changes you made before closing. 

 To close a file and save your latest changes:
    1. Click the  File  tab to open Backstage view.  
   2. Click the  Close  button.  
   3. If you have made no changes since the last time you saved the file, it will close 

immediately. If changes have been made, the application displays a message box asking if 
you want to save the changes you made before closing. 
   Click  Save  to save the changes.  
  Click  Don’t   Save  to close the file without saving your latest changes.  

    Click  Cancel  to keep the file open.      

Click Close to close the file.

FIGURE OF 1.7

To close a file, you can also press Ctrl  + W  on the keyboard.

another method

If necessary, open the student data file of1-SpaNewsletter and try this skill on your own:
Close the fi le.

let me try
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  Skill 1.4 Getting to Know the Office 
2013 User Interface 

  THE RIBBON 
 If you have used a word processing or spreadsheet program in the past, you may be surprised 
when you open one of the Microsoft Office 2013 applications for the first time. Beginning 
with Office 2007, Microsoft redesigned the user experience—replacing the familiar menu 
bar/toolbar interface with a new Ribbon interface that makes it easier to find application 
functions and commands. 

 The    Ribbon    is located across the top of the application window and organizes common 
features and commands into tabs. Each    tab    organizes commands further into related    groups    .  

FIGURE OF 1.8
The Ribbon

File Tab (Opens Backstage View) Tab Contextual Tab

Command

Group

 When a specific type of object is selected (such as a picture, table, or chart), a contextual tab 
will appear.    Contextual tabs    contain commands specific to the type of object selected and are 
only visible when the commands might be useful. 

 Each application includes a    Home tab    that contains the most commonly used commands 
for that application. For example, in Word, the  Home  tab includes the following groups: 
Clipboard, Font,   Paragraph,   Styles,  and  Editing,  while the Excel  Home  tab includes groups 
more appropriate for a spreadsheet program:  Clipboard,   Font,   Alignment,   Number,   Styles,  
 Cells,  and  Editing.  

If you need more space for your file, you can minimize the Ribbon by clicking the Collapse the Ribbon button in the 
upper-right corner of the Ribbon (or press Ctrl  + F1 ). When the Ribbon is minimized, the tab names appear along 
the top of the window (similar to a menu bar). When you click a tab name, the Ribbon appears. After you select 
a command or click away from the Ribbon, the Ribbon hides again. To redisplay the Ribbon permanently, click the 
Ribbon Display Options button in the upper-right corner of the window and select Show Tabs and Commands. You can 
also double-click the active tab to hide or display the Ribbon.

tips & tricks

  BACKSTAGE 
 Notice that each application also includes a    File tab    at the far left side of the Ribbon. Click-
ing the  File  tab opens the    Microsoft Office Backstage view    ,  where you can access the com-
mands for managing and protecting your files, including  Save,   Open,   Close,   New,  and  Print.  
Backstage replaces the Office Button menu from Office 2007 and the  File  menu from previ-
ous versions of Office. 

 To return to you file from Backstage view, click the  Back  button located in the upper left 
corner of the window.      
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 KEYBOARD SHORTCUTS 
 Many commands available through the Ribbon and Backstage view are also accessible 
through keyboard shortcuts and shortcut menus. 

  Keyboard shortcuts    are keys or combinations of keys that you press to execute a command. 
Some keyboard shortcuts refer to F keys or function keys. These are the keys that run across 
the top of the keyboard. Pressing these keys will execute specific commands. For example,

pressing the F1 key will open Help in any of the Microsoft Office 
applications. Keyboard shortcuts typically use a combination of 
two keys, although some commands use a combination of three 
keys and others only one key. When a keyboard shortcut calls for 
a combination of key presses, such as Ctrl  + V    to paste an item 
from the  Clipboard,  you must first press the modifier key Ctrl   , 
holding it down while you press the V  key on the keyboard. 

FIGURE OF 1.9

Press and hold Ctrl and 
then press V to paste 
text or item in a file.

Many of the keyboard shortcuts are universal across all applications—not just Microsoft Office applications. Some 
examples of universal shortcut keys include:

Ctrl  + C  = Copy

Ctrl  + X  = Cut

Ctrl  + V  = Paste

Ctrl  + Z  = Undo

Ctrl  + O  = Open

Ctrl  + S  = Save

tell me more

 SHORTCUT MENUS 
    Shortcut menus    are menus of commands that 
display when you right-click an area of the 
application window. The area or object you 
right-click determines which menu appears. 
For example, if you right-click in a para-
graph, you will see a shortcut menu of com-
mands for working with text; however, if you 
right-click an image, you will see a shortcut 
menu of commands for working with images. 

FIGURE OF 1.10
Right-Click Shortcut Menu
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 THE MINI TOOLBAR 
 The    Mini toolbar    gives you access to common tools for working 
with text. When you select text and then rest your mouse over 
the text, the Mini toolbar fades in. You can then click a button to 
change the selected text just as you would on the Ribbon. 

To display the Mini toolbar, you can also right-click the text. 
The Mini toolbar appears above the shortcut menu.

another method

FIGURE OF 1.11

 QUICK ACCESS TOOLBAR 
 The    Quick Access Toolbar    is located at the 
top of the application window above the 
File  tab. The Quick Access Toolbar, as its 
name implies, gives you quick one-click 
access to common commands. You can add 
commands to and remove commands from 
the Quick Access Toolbar. 

 To modify the Quick Access Toolbar:
    1. Click the  Customize Quick Access 

Toolbar  button located on the right 
side of the Quick Access Toolbar.  

   2. Options with checkmarks next to them 
are already displayed on the toolbar. 
Options with no checkmarks are not 
currently displayed.  

   3. Click an option to add it to or remove 
it from the Quick Access Toolbar.    

The Mini Toolbar

If you want to be able to print with a single mouse click, add the Quick Print button to the Quick Access Toolbar. If 
you do not need to change any print settings, this is by far the easiest method to print a file because it doesn’t require 
opening Backstage view first.

tips & tricks
FIGURE OF 1.12

Options with checkmarks 
next to them are already 
displayed on the Quick 
Access Toolbar.

Options with no 
checkmarks are not 
currently displayed.

Quick Access Toolbar
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 ENHANCED SCREENTIP 
 A    ScreenTip    is a small information box that displays the name of 
the command when you rest your mouse over a button on the 
Ribbon. An    Enhanced ScreenTip    displays not only the name of 
the command, but also the keyboard shortcut (if there is one) and 
a short description of what the button does and when it is used. 
Certain Enhanced ScreenTips also include an image along with a 
description of the command. 

FIGURE OF 1.13
Cover Page 

Enhanced ScreenTip

 USING L IVE PREVIEW 
 The    Live Preview    feature in Microsoft Office 2013 allows you to see formatting changes in 
your file before actually committing to the change. When Live Preview is active, rolling over 
a command on the Ribbon will temporarily apply the formatting to the currently active text 
or object. To apply the formatting, click the formatting option. 

 Use Live Preview to preview the following:
Font Formatting —Including the font, font size, text highlight color, and font color  
Paragraph Formatting —Including numbering, bullets, and shading  

     Quick Styles and Themes   
     Table Formatting —Including table styles and shading  
     Picture Formatting —Including correction and color options, picture styles, borders, 

effects, positioning, brightness, and contrast  
     SmartArt —Including layouts, styles, and colors  
     Shape Styles —Including borders, shading, and effects    

The Live Preview feature allows you to see formatting 
changes in your file before committing to them.

FIGURE OF 1.14
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  THE OPTIONS DIALOG 
 You can enable and disable some of the user interface features through the  Options  dialog. 
    1. Click the  File  tab to open Backstage view.  
   2. Click  Options.   
   3. Make the changes you want, and then click  OK  to save your changes. 
    ❱ Check or uncheck  Show Mini toolbar on selection  to control whether or not the 

Mini toolbar appears when you hover over selected text. (This does not affect the 
appearance of the Mini toolbar when you right-click.)  

❱ Check or uncheck  Enable Live Preview  to turn the live 
preview feature on or off.  

   ❱ Make a selection from the  ScreenTip 
style  list:

    •  Show feature descriptions in 
ScreenTips  displays Enhanced 
ScreenTips when they are available.  

   •  Don’t show feature descriptions 
in ScreenTips  hides Enhanced 
ScreenTips. The ScreenTip will still 
include the keyboard shortcut if 
there is one available.  

   •  Don’t show ScreenTips  hides 
ScreenTips altogether, so if you hold 
your mouse over a button on the 
Ribbon, nothing will appear.        

Open the student data file of1-SpaNewsletter and try this skill on your own:
  1. Explore the Ribbon. Click on different tabs and note how commands are arranged together in groups.
  2. Click the picture to display the Picture Tools contextual tab.
  3. Click the File tab to display Backstage view. Click the Back button to return to the fi le.
  4. Right-click an area of the fi le to display the shortcut menu.
  5. Explore the Mini Toolbar at the top of the shortcut menu. Click away from the menu to hide it.
  6. Click the Customize Quick Access Toolbar arrow to display the menu of items that can be displayed on the 

Quick Access Toolbar. Note the ones with checkmarks are the items currently displayed.
  7. Click the Insert tab. In the Pages group, roll your mouse over the Cover Page button to display the Enhanced 

ScreenTip.
  8. Click the File tab.
  9. Click Options to open the Options dialog.
 10. Disable Live Preview.
 11. Change the ScreenTips so they don’t show feature descriptions.
 12. Close the fi le.

let me try

You can enable and disable some of the user 
interface features through the Options dialog.

FIGURE OF 1.15
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 A BUSY PARENT 

 Learning Microsoft Office was one of the best things I did to help manage my family’s busy 
lifestyle. I use Word to write up and print a calendar of everyone’s activities for the week. I 
keep a handle on the family finances with a budget of all expenses in an Excel spreadsheet. 
I’ve even learned how to use Excel to calculate loan payments and found the best offer when 
I had to buy a new family car. I used PowerPoint to create a presentation for my family of our 
summer vacation pictures. Once I became more familiar with Access, I used it to help organize 
my family’s busy schedule. I created a database with one table for activities, another for parent 
contact information, another one for carpooling, and another one for the schedule. Being able 
to organize all the information in a database has been invaluable. I always thought Office was 
only for businesses, but now I can’t imagine running my household without it!         

 Skill 1.5 Using the Start Page 
 When you launch an Office 2013 application you are first taken to the    Start page    .  The  Start
page gives you quick access to recently opened files and templates for creating new files in 
each of the applications. 

 To open a recent file from the
 Start  page:
    1. Launch the application.  
   2. The  Start  page displays.  
   3.  Click a file in the left pane to 

open the file.    

If you do not see the file you want to open in the list of recent files, click Open Other Documents at the bottom of the 
left pane. This will display the Open page that includes buttons for finding and opening files from other locations such 
as your computer or your SkyDrive.

tips & tricks

In previous versions of Office when you launched an 
application, a blank file opened ready for you to begin 
working. If you want to start a new blank file, click the 
blank file template in the list of templates. It is always 
listed as the first option.

tell me more
To try this skill on your own:
 1. Launch Microsoft Word.
 2. If you have fi les listed under Recent, click a fi le to 

open it.
 3. Close the fi le.

let me try

FIGURE OF 1.16

Recently opened files are listed here.

  from the perspective of . . . 
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 Skill 1.6 Changing Account Information 
 Office 2013 includes an    Account page    that lists information for the user currently logged 
into Office. This account information comes from the Microsoft account you used when 
installing Office. From the  Account  page, you can update your user profile, including contact 
and work information. You can also change the picture associated with the user account. 

 To change the user information
     1. Click the  File  tab.  
    2. Click  Account.   
    3. The current user profile is listed under  User Information.   
  4. Click the  Change photo  link.

User information is displayed here.

Click Account to display 
the Account page.

FIGURE OF 1.17

   5. The  Profile  page on   live.com   is displayed in the browser window. 
    6. Click the  Change Picture  link.  
    7. On the  Picture  page, click the  Browse  button.  
    8. Navigate to the location of the picture you want to use for you profile and select it.  
    9. Click the  Open  button.  
   10. The picture appears on the page. Click the  Save  button to save the profile change.    
 From the  Profile  page, you can also edit your contact information and work information. 
Click the  Edit  link under each section to display the edit page. Fill in the form with your 
information and click the  Save  button. 
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Depending on the version of Office 2013 you have, you can have multiple accounts use the same installation of 
Office. When you switch accounts, any personalization that person has done to Office will be applied. The account 
will also have access to that person’s SkyDrive account and all files that have been saved there. To learn more about 
SkyDrive, see the skill Saving Files to a SkyDrive.

tell me more

To change the user photo, you can also click the arrow next to the user name in the upper right corner of the window 
and click the Change photo link.

another method

Open the student data file of1-SpaNewsletter and try this skill on your own:
 1. Open the Account page in Backstage view.

NOTE: If you are using this in class or in your school’s computer lab, check with your instructor about permissions 
before completing the following steps.

 2. Change the photo for the user account.
 3. Change the picture using a photo of your choice.
 4. Save the changes to the picture.
 5. Close the browser window.
 6. Keep this fi le open for working on the next skill.

let me try

FIGURE OF 1.18

Click Edit to change other 
account information.

Click Change picture 
to change the image 
for the user profile.
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 Skill 1.7 Changing the Look of Office 
 In addition to managing the Office account, you can also control the look of Office from 
the  Accoun t page. Changing the Office background changes the background image that dis-
plays in the upper right corner of the window near the user profile. Changing the Office 
theme changes the color scheme for Office, affecting the look of the Ribbon and dialogs. 

 To change the look of Office:
    1. Click the  File  tab to open Backstage view.  
   2. Click  Account.   
   3. Click the  Office Background  drop-down list and select an option to display as the 

background.  
   4. Click the  Office   Theme  drop-down list and select a color option for your applications.    

If necessary, open the student data file of1-SpaNewsletter and try this skill on your own:
 1. Open the Account page in Backstage view.

NOTE: If you are using this in class or in your school’s computer lab, check with your instructor about permissions 
before completing the following steps.

 2. Change the Offi ce background to the Circuit background.
 3. Change the Offi ce color to Light Gray.
 4. Close the fi le.

let me try

Click here to change 
the background.

Click here to change 
the Office theme.

Click Account to display 
the Account page.

FIGURE OF 1.19
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 Skill 1.8 Working in Protected View 
 When you download a file from a location that Office considers potentially unsafe, it opens 
automatically in    Protected View    .  Protected View provides a read-only format that protects 
your computer from becoming infected by a virus or other malware. Potentially unsafe loca-
tions include the Internet, e-mail messages, or a network location. Files that are opened in 
Protected View display a warning in the Message Bar at the top of the window, below the 
Ribbon. 

 To disable Protected View, click the  Enable Editing  button in the Message Bar. 

You can also enable editing from the Info page in Backstage.
 1. Click the File tab to open Backstage.
 2. Click Info.
 3. The Info page provides more information about the fi le. If you are sure you want to remove it from Protected 

View, click the Enable Editing button.

another method

Open the student data file of1-SpaNewsletter and try this skill on your own:
 1. If you downloaded the fi le from the Internet, the fi le will open in Protected View.
 2. Click the Enable Editing button to begin working with the fi le.
 3. Close the fi le.

let me try

To learn more about the security settings in Office 2013, open the Trust Center and review the options. We do not 
recommend changing any of the default Trust Center settings.

tips & tricks

FIGURE OF 1.20

Click Enable Editing to 
begin working on the file.
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 Skill 1.9 Picking Up Where You Left Off 
 When you are working in a long document or a presentation and reopen it to work on it, 
you may not remember where you were last working. Office 2013 includes a new feature 
that automatically bookmarks the last location that was worked on when the file was closed. 

 To pick up where you left off in a document or presentation:
    1. Open the document or presentation.  
   2. A message displays on the right side of the screen welcoming you back and asking if you 

want to pick up where you left off. The message then minimizes to a bookmark tag.  
   3. Click the  bookmark tag  to navigate to the location.    

FIGURE OF 1.21

Click here to navigate 
to the last location.

Open the student data file of1-09-SpaNewsletter and try this skill on your own:
 1. Navigate to the location where the last location the fi le was at when last closed.
 2. Close the fi le.

let me try

The bookmark tag only displays until you navigate to another part of the document. If you scroll the document, the 
bookmark tag disappears.

tips & tricks

This feature is only available in Word and PowerPoint. Excel and Access do not give you the option of picking up 
where you left off when you open a file.

tell me more
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 Skill 1.10 Creating a New Blank File 
 When you first open an Office application, the  Start  page displays giving you the opportu-
nity to open an existing file or create a new blank file or one based on a template. But what 
if you have a file open and want to create another new file? Will you need to close the appli-
cation and then launch it again? The    New command    allows you to create new files without 
exiting and reopening the program. 

 To create a new blank file:
    1. Click the  File  tab to open Backstage view.  
   2. Click  New.   
   3. The first option on the  New  page is a blank file. Click the  Blank document  thumbnail 

to create the new blank file.    

FIGURE OF 1.22

Click Blank document 
to create a new blank file.New

In addition to a blank file, you can create new files from templates from the New page.

tell me more

To bypass the Backstage view and create a new blank file, press Ctrl  + N  on the keyboard.

another method

Open the student data file of1-SpaNewsletter and try this skill on your own:
 1. Create a new blank fi le.
 2. Close the fi le but do not save it.

let me try
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 Skill 1.11 Using Help 
 If you don’t know how to perform a task, you can look it up in 
the    Office Help    system. Each application comes with its own Help 
system with topics specifically tailored for working with that 
application. 

 To look up a topic using the Microsoft Office Help system:
    1. Click the  Microsoft Office Help  button. It is located at the 

far right of the Ribbon.  
   2. Click in the  Search online help   box  and type a word or phrase 

describing the topic you want help with.  
   3. Click the  Search  button.  
   4. A list of results appears.  
   5. Click a result to display the help topic.    

FIGURE OF 1.23

Type the word or phrase 
you want to search for here.

List of Results

FIGURE OF 1.24

Help Button

Search Button

To open the Help window, you can also press F1  on the keyboard.

another method

Open the student data file of1-SpaNewsletter and try this skill on your own:
 1. Click the Microsoft Offi ce Help button.
 2. Search for topics about themes.
 3. Click a link of your choice.
 4. Close the Help window.
 5. Keep this fi le open for working on the next skill.

let me try

To search for topics in Microsoft Office Help, you must have an active Internet connection. If you are working offline 
(not connected to Office.com), Help is still available, but it is limited to information about finding buttons of the Ribbon.

tips & tricks

The Help toolbar is located at the top of the Help window. This toolbar includes buttons for navigating between 
screens, changing the size of text, and returning to the Help Home page. Click the printer icon on the toolbar to print 
the current topic. Click the pushpin icon to keep the Help window always on top of the Microsoft Office application.

tell me more
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 Skill 1.12 Working with File Properties 
  File Properties    provide information about a file such as the location of the file, the size of file, 
when the file was created and when it was last modified, the title, and the author. Properties 
also include keywords, referred to as    tags    ,  that are useful for grouping common files together 
or for searching. All this information about a file is referred to as    metadata    .  

 To view a file’s properties, click the  File  tab to open Backstage view. Properties are listed 
at the far right of the  Info  tab. To add keywords to a file, click the text box next to  Tags
and type keywords that describe the file, separating each word with a comma. The Author 
property is added automatically using the account name entered when you installed and reg-
istered Office. You can change the author name or add more names by editing the Author 
property. 

If necessary, open the student data file of1-SpaNewsletter and try this skill on your own:
 1. Add a tag to the document that reads newsletter.
 2. Keep this fi le open for working on the next skill.

let me try

Some file properties are generated automatically by Windows and cannot be edited by the user, such as the date the 
file was created and the size of the file.

tips & tricks

FIGURE OF 1.25

Keyword Tags

Author

File Properties

tri16457_ch01_OF1-OF30.indd   22tri16457_ch01_OF1-OF30.indd   22 5/20/13   5:13 PM5/20/13   5:13 PM



Rev.confirming Pages

www.mhhe.com/simnet  OF–23
skill 1.13 Saving Files to a Local Drive

 Skill 1.13 Saving Files to a Local Drive 
 As you work on a new file, it is displayed on-screen and stored in your computer’s memory. 
However, it is not permanently stored until you save it as a file to a specific location. The first 
time you save a file, the  Save As  page in Backstage view will display. Here you can choose to 
save the file to your SkyDrive, your local computer, or another location. 

 To save a file to a local drive:
    1. Click the  Save  button on the Quick Access Toolbar.  
   2. The  Save As  page in Backstage view appears.  
   3. On the left side of the page, click  Computer  to save the file to a local drive.  
 4. Word displays a list of recent folders; select a folder where you want to save the file.

FIGURE OF 1.26

Click Computer to save 
the file to a local drive.

Select a location 
to save the file to.

   5. The  Save As  dialog opens.  
   6. If you want to create a new folder, click the  New Folder  button near the top of the file 

list. The new folder is created with the temporary name  New Folder.  Type the new name 
for the folder and press  Enter.   

   7. Click in the  File name  box and type a file name.  
   8. Click the  Save  button.    
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 The next time you save this file, it will be saved with the same file name and to the same 
location automatically. 

 As you are working with files, be sure to  save often!  Although Office 2013 includes a 
recovery function, it is not foolproof. If you lose power or your computer crashes, you may 
lose all the work done on the file since the last save. 

FIGURE OF 1.27

Type the file name here.

Save Button

To save a file, you can also:

 ❱ Press Ctrl  + S  on the keyboard.

 ❱ Click the File tab, and then select Save.

 ❱ Click the File tab, and then select Save As.

another method

Try this skill on your own:
 1. Create a new blank fi le.
 2. Save the fi le to the My Documents folder on your computer. Name the fi le BlankFile.
 3. Close the fi le.

let me try

If the location where you want to save the file is not listed under Recent Folders, click the Browse button to open the 
Save As dialog. Navigate to the location where you want to save the file.

tips & tricks
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 Skill 1.14 Saving Files to a SkyDrive 
  SkyDrive    is Microsoft’s free cloud storage 
where you can save documents, workbooks, 
presentations, videos, pictures, and other 
files and access those files from any computer 
or share the files with others. When you save 
files to your SkyDrive, they are stored locally 
on your computer and then “synched” with 
your SkyDrive account and stored in the 
“cloud” where you can then access the files 
from another computer or device that has 
SkyDrive capability. 

 To save a file to your SkyDrive:
    1. Click the  File  tab.  
   2. Click  Save As.   
   3. Verify the SkyDrive account is selected 

on the left side of the page.  
   4. Under  Recent Folders,  click the 

SkyDrive  account you want to save to.  
   5. The  Save As  dialog opens to your 

SkyDrive folder location on your 
computer.  

   6. Click in the  File name  box and type a file name.  
   7. Click the  Save  button.    

If necessary, open the student data file of1-SpaNewsletter and try this skill on your own:
 1. Save the fi le to the Documents folder on your SkyDrive. NOTE: If you are using this in class or in your school’s 

computer lab, check with your instructor before completing this step.
 2. Keep this fi le open for working on the next skill.

let me try

By default, your SkyDrive includes folders for documents, pictures, and files you want to make public. You can save 
your files in any of these folders or create your own. To create a new folder in your SkyDrive, click the New Folder
button near the top of the file list. The new folder is created with the temporary name New Folder. Type the new name 
for the folder and press Enter .

tips & tricks

When you are working on an Excel or Word file that has been saved to your SkyDrive, others can work on the file at 
the same time you are working the file. The application will mark the area being worked on as read only so others 
cannot modify the same information you are working on. However, if you are sharing a PowerPoint presentation, only 
one user at a time can work on the presentation.

tell me more

SkyDrive Location on Your Computer

Save Button

FIGURE OF 1.28
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 Skill 1.15 Saving Files with a New Name 
 When working on files you may want to save a file but not overwrite the original file you 
opened. In this case, you should save the file with a new name. When you save a file with 
a new name, the original file still exists in its last saved state and the new file you save will 
include all the changes you made. 

 To save a file with a new name:
    1. Click the  File  tab.  
   2. Click  Save As.   
   3. Select a location to save the file, either your SkyDrive or your local drive.  
   4. In the  Save As  dialog, click in the  File name  box, type a new name for the file, and click 

 Save.     

FIGURE OF 1.29

If necessary, open the student data file of1-SpaNewsletter and try this skill on your own:
 1. Save the fi le to the Documents folder on your computer with the name SpaNewsletter.
 2. Keep this fi le open for working on the next skill.

let me try

Beginning with Office 2007, Microsoft changed the file format for Office files. If you want to share your files with 
people who are using Office 2003 or older, you should save the files in a different file format.

 1. In the Save As dialog, click the arrow at the end of the Save as type box to expand the list of available file types.

 2. To ensure compatibility with older versions of Office, select the file type that includes 97-2003 (for example, 
Word 97-2003 Document or Excel 97-2003 Workbook).

tell me more

Type the new file name here.

Save Button
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 Skill 1.16 Closing the Application 
 When you close a file, the application stays open so you can open another file to edit or begin 
a new file. Often, when you are finished working on a file, you want to close the file and exit 
the application at the same time. In this case, you will want to close the application. 

 To close an application:
    1. Click the  Close  button in the upper-right corner of the application.  
   2. If you have made no changes since the last time you saved the file, it will close 

immediately. If changes have been made, the application displays a message box asking if 
you want to save the changes you made before closing. 
   Click  Save  to save the changes.  
  Click  Don’t   Save  to close the file without saving your latest changes.    
  Click  Cancel  to keep the file open.    

FIGURE OF 1.30

Click the Close button 
to exit the application.

Click Save to save 
any changes made.

Click Don’t Save to 
close without saving.

If necessary, open the student data file of1-SpaNewsletter and try this skill on your own:

Close the application.

let me try

To close the application, you can also:

 ❱ Right-click the title bar and select Close.

 ❱ Click the application icon in the upper-left corner of the application and select Close.

another method
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    1. Microsoft        is a spreadsheet program. 
    a. Word  
   b. Excel  
   c. Access  
   d. PowerPoint    
   2. Click the        tab to display Backstage view. 
    a. File  
   b. Home  
   c. View  
   d. Contextual    
   3. To display a shortcut menu        an area of the file. 
    a. left-click  
   b. right-click  
   c. double-click  
   d. None of the above    
   4. If you have downloaded a file from the Internet and it opens in Protected View, you 

should never open the file. 
    a. True  
   b. False    
   5. The        is located across the top of the application window and organizes 

common features and commands into tabs. 
    a. menu bar  
   b. toolbar  
   c. title bar  
   d. Ribbon    

   key terms 
   Microsoft Word  
  Microsoft Excel  
  Microsoft PowerPoint  
  Microsoft Access  
  Ribbon  
  Tab  
  Groups  
  Contextual tabs  
  Home tab  
  File tab  
  Backstage  
  Keyboard shortcuts  
  Shortcut menus  
  Mini toolbar  

  Quick Access Toolbar  
  ScreenTip  
  Enhanced ScreenTip  
  Live Preview  
  Start page  
  Account page  
  Protected View  
  New command  
  Office Help  
  File Properties  
  Tags  
  Metadata  
  SkyDrive    

  concepts review 
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   6. The        provide(s) information about a file such as the location of the file, the 
size of file, when the file was created and when it was last modified, the title, and the 
author. 

    a. file properties  
   b. user profile  
   c. account information  
   d. Options dialog    
   7. When you save files to your SkyDrive, they are available to access from other computers 

that have SkyDrive capability. If you are working on an Excel or Word file, others can 
be working on the same file at the same time you are working on the file. 

    a. True  
   b. False    
   8. You can change user information from the        page in Backstage view. 
    a. Account  
   b. Options  
   c. Share  
   d. Info    
   9. To paste an item from the  Clipboard,  use the keyboard shortcut       . 
    a.     Ctrl  + C       
   b.     Ctrl  + X       
   c.     Ctrl  + V       
   d.     Ctrl  + P      
   10. The        gives you quick one-click access to common commands and is located 

at the top of the application window above the  File  tab. 
    a. Ribbon  
   b. Quick Access Toolbar  
   c. Options dialog  
   d. Backstage view        
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